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Introduction

Welcome to the Oracle Insurance QuickView Service Ordering User Guide. With Oracle
Insurance QuickView Service Ordering (QuickView), the Writing Agent will be able to:

e Create a Service Order
o View Status of a Service Order
e Search for a Service Order

QuickView is a processing portal that allows agents and agencies to view their pending case
status and commissions from the multiple Life Brokerage Insurance Carriers on one web site.

This guide will discuss the following topics and get you started using QuickView Service Ordering.

Configuring your browser for use with QuickView Service Ordering.

Logging into QuickView Service Ordering and the Home Page.

Adding orders to the system.

Checking the status of your orders.

Viewing the orders that have had recent activity by Service Providers.
Searching for orders using either the Quick Search or Detailed Search tools.

Audience

This guide is intended for QuickView Users who want to quickly view their orders.

Internet Explorer Settings

QuickView is a web application that requires certain permissions and controls in order to properly
interact with an end user's desktop and file system.

work properly. You also can enable popups for this site.

NOTE If you have a popup blocker installed, you may need to disable it for QuickView to

Browser Configuration

It is recommended that you navigate through QuickView using the application commands found
on the left hand side of the screen or at the top of the application screen. Using the Back or
Forward buttons on your internet browser bar may result in errors and lost information. You may
want to temporarily remove the Standard Buttons from your browser while using QuickView.
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Removing Standard Buttons

To temporarily remove the Standard Buttons on Internet Explorer:
e Click View>Toolbars>»Standard Buttons. The standard button toolbar will be removed.
OR
o Depress the Alt key and then V+T+S.

Repeat either procedure to restore the Standard Buttons.

NOTICE: This step is entirely optional. If you do not configure your browser in this way, be sure
to avoid using the forward and back buttons while navigating through QuickView.

Clearing Temporary Files

Because QuickView is web-based, you may need to clear out your browser’s temporary file
periodically.

Keeping the temporary file clear may improve performance by clearing off space from your hard
drive.

Inactivity / Timeout

QuickView, a web-based application, will log you out if you are inactive for a length of time. The
default setting is 5 minutes but you can adjust that as needed. If timeout does occur, log back
onto the system and continue working.

Basic Safety Precautions

It is recommended that you secure your computer when you need to step away. This prevents
any unintentional deletions or entries and protects the integrity of your work.

Notational Conventions

This section explains the conventions used in this guide:

e Menu selections are shown with arrows. For example, the command to select the Print
choice from the File menu looks as follows:
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Select File » Print
e Screen options and selections are shown in bold.

o New or emphasized terms are shown in italics.

Additional Information

For more information, please go to the Oracle Insurance web site at
http://www.oracle.com/industries/insurance/index.html or call 888-486-4683.

Manual History

New editions incorporate any updates issued since the previous edition.

Publication Product

Edition : Publication Date Comment
Number Version
~1% Edition P01-303-01 V1.0 February 2007 Initial Creation
2" Edition  P01-303-02 V1.0 February 2008 Update
3" Edition P01-303-03 V1.0 February 2009 Update
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Introduction to QuickView

Logging into QuickView

Accessing QuickView can be done in a few ways. QuickView may be presented as an option from
your company’s portal page or you may be given an internet address to connect to. If you receive
a QuickView Service Ordering account you will be given:

Internet Address (or URL).
UserlD and a password. Be sure to write down this information and keep it in a safe
place.

To enter the QuickView Service Ordering application:

Enter the URL you were given into your Internet browser. You will be placed on a
login screen.

Enter in your UserID and Password.

Press Enter to log in. You will be on the Home Page.

& [Oracle QuickView] - Home Page - Windows Internet Explorer

G@ v | ] s idemo it com/gv/MODULE_HOME,do?ONARPINIT=VEMODULE =gy | @ certicate |2l [Lve search

‘.} @& lg[orade QuickView] - Home Page ]7| Eﬁ M % M @Page 4 @’TOO‘S -7

ORACLE"
INSURANCE QuickView Home Page

search: [Policy (by Poicy o) e | | &3

What's New in Data Movement?

Two Way Communication New Data Movement Partners

Click Here for More Information
Fidelity Life Association

our carrier partners have warked hard ta make | Old Mutual Financial Network (F&G)
your jobs easier by submitting additional types

of data to the Skywire Software IDX Hub. You can also request Commission

information from the following
Please review the list of Carriers to confirm you | carriers
are receiving the most recent feeds.

. " Prudential
Contact our Skywire Software QuickView Mutual of Omaha

Support Team at 1-888-486-4583 or QuickView MetLife of Connecticut

Suppart for assistance! Lincoln Benefit Life
Genworth

Coming soon!
Now Available 9
CE Credits
AIG Commissions

Principal Commissions
Skywire Software is now 0Old Mutual Financial Pending
offering CE credits online MetLife Commissions

Writing Agent User. test test Copyright ® 2008, Oracle. All rights reserved.

JavaserptshowhewCrderForm {'QV_CROER,_DETAILS. do?ACTIONCODE =NEWORDERBNOCACHE=Y') | @€ neme | R0 -
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The options this guide will focus on are located on the left hand side of the screen under Service
Orders. From the Home Page, you can create a new order, view orders, or search orders.

If you attempt to log in with the wrong password four times in a row, your account will
be locked and you will receive the following message:

NOTE

“Your account has been locked. Please call the Oracle Insurance QV Help Desk at 1-
888-486-4683 to un-lock your account!”

QuickView Service Ordering Functionality

This section describes navigating and entered items in QuickView Service Ordering.

Drill Down

To drill down into an order and see more details, click on the underlined text. This may not be
displayed on some screens.

Sorting

Lists can be sorted from Descending to Ascending or Ascending to Descending order by clicking
the column heading.

Changing Update Notification Criterion

When you select the Update screen, you will be notified of orders that have been updated since
you last logged in. If you want to change the criterion for what is displayed in the update screen,
go to the Tools>»Preferences>»Service Order Settings screen using the link at the top of the
window.

IN[@JB=8] You can change various account settings in the Preferences screen.

Service Order Settings

To change your criterion for order update notification, go to the Tools>»Preferences screen:
e Click Service Order Settings.

e Scroll down to the Display Order with Updates dropdown menu and select the option
you want.

If you select Within last 24 hours as a setting for service order notifications, the next time you

log in or access the Update screen, you will see all the orders that have been updated within the
last 24 hours.
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QuickView Features and Requirements

The following describes some of the features and requirements of QuickView.

Conditionally Required Fields

Fields that are not marked with asterisks may be conditionally required. For example, normally a
Drivers License is not required, but when you specify Prepare Motor Vehicle Report a Drivers
License Number will be required. If you have not entered the required information, a reminder
popup message will be displayed.

Highlighted Fields

If you have not completed the required fields and try to advance to the next screen, a popup
message will be displayed listing the fields that are required. When you close the popup, the
fields that need to be completed before you can advance to the next step will be highlighted.

Drop Down List Boxes

You can save time by selecting options from a drop down menu without using the mouse. Tab to
the field and press the first letter of option you want. This will allow you to use the mouse when
you need to look at the menu.

When the input is on a field with a drop down menu, you can use the up and down

NOTE arrows until you see the option you need.

City/State/ZIP

City and State information can be entered manually. You also can enter the ZIP Code first and
click Set City/State for the ZIP Code. This will pull in the corresponding City and State.

Popup Screens

In QuickView, all popup screens work the same and have the same three buttons. Each popup
screen will have the following buttons:

e Reset — Clicking Reset will remove information previously entered and allow you to start
again.

e Close — Click Close when you want to close the popup screen without saving any
information.

e Save — Save will save the information entered on the popup.
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New Orders

The New Order screen has three sections: Carrier, Case, Requirements. Clicking the section
name on the left hand side of the New Order screen will take you to that section.

Adding New Orders

e To create a new Service Order, click the Service Order Tab.
o Click New Order.

After you click New Order, the New Order screen will be displayed.

e Complete all required fields — All required fields are marked with an asterisk.
e Click Submit Order.

If necessary, you can click Reset This Section to clear out all information previously
entered and allow you to start over.

& [Oracle QuickView] - Order Details -- [NEW] - Windows Internet Explorer

& https:/fdemo Lindx.com/qv/QY_ORDER_DETAILS,do?ACTICNCCDE=NEWORDERBNOCACHE=YENEWWIN=Y M @ Certificate

el nnect “LAMEr | _select Carrier— | | [Cick nere if vour cannot e 8ll vour carrisrs]

APPLICANT INFO
Case
* First Name. ML * Last Name:

Requirements =DOB (MW/DDIYY =

[Put On Hold] - S8N - -
. Driver License No (MVR) Siate lssued (MVA):| ~Select — |

[CLICK HERE TO ADD A NEV/ ADDRESS]
* Addresses
[CLICK HERE TO ADD A NEVY PHONE]
“Phones
[CLICK HERE TO ADD A NEVI EMAIL]
Emails:

Reset This Section SUBMIT ORDER

CASE INFO

Base Plan:| _select Base Plan—

* Face Amount (numeric)

Policy Ne:

Application Jurisdiction: | _.Select Application Jurisdiction-- %

“Agent| _Select Agent- v
Reset This Secfion SUBMIT ORDER

REQUIREMENTS
EXAM Services: |  select Service Provider — | %

@) Let examination company select Exam Services

Exam Date/Time: | [E=]7] | - scheduled Time - v

Notes (up to 1000 chars)

Reset This Section SUBMIT ORDER

Dane [3 @ ntermet #100% -
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Carrier / Applicant Information

The Applicant Information section is where the required information for the applicant is entered
and the carrier is selected.

The carrier must be selected first. The Case and Requirements fields will b populated based on
the carrier. The Carrier dropdown menu will display the Carriers that have been set up with a
Service Provider. If a Carrier has not been set up with a Service Provider their name will not be
displayed in the Carrier dropdown menu.

Case Information

The Case Information section is where the required case information is entered. The options
available in the case section will depend upon the carrier selected. You will not be able to
complete this section until a carrier is selected.

Requirements

The Requirements section is where the required services information is entered.

Exam Services

When you choose Exam Services you can request a specific exam date in the space underneath
the exam order description. You also can request an exam time from the dropdown menu. If you
need to specify a provider for an exam service, you will see a dropdown menu indicator.

Adding Requirements

To add requirements you will need to select the service provider for exam services and choose:

e Let examination company select the Exam Services — Use this option when you want
the examination company to select the exam services. If you want this option, click the
button in front of the option.

o Let me select Exam Services — Use this option when you want to select the exam
services.

Notes

If you have a special requirement or need to communicate with an exam company, you can add
notes in the notes input area on the screen.
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Physician Detail Screen

If you opt to select the Exam Service, you may need to enter Physician detail. Click the [Add
New Physician] link and a Physician Detail Screen will be displayed.

A Physician Detail -- Webpage Dialog

€| htips:/{demo Litidx.com/gv/idt_redirect. app?MODAL=idt_enter_physician_dialog.ag ¥ B4 certificate

Org Name:|

First Name: |

Widdle Mame:

Last Name: |

Addresstyneil Unknown ™

Address #1: |

Address #2: |

Address #3: |
* City: |

* State! | gelect a State  w

Zip Code: | . Set City/State for the Zip Code

Phone t3‘I2|f=3| Select Phone Type |+ |

Phone number: [ | 1 - Ext:

| reser [f save [ close |

htipos: ffidemo Litid:, com,/qv fidt_redirect. app?MODAL=idt_enfer_physician_c g Internet E] 5t

Enter in the Physician Information and click Save to save your entry and return to the order. You
can enter additional Physicians if needed. Close will close the popup without saving your
information. Reset will clear the fields.

Additional Information Popups

There will be areas where you need to enter in more than one piece of information. For example,
you may need to enter a mailing address and a home address. The address, phone, and email
screens allow for multiple entries.

Click the add link in the address, phone or email box. A separate popup will be displayed. You
must select the type from the drop down window at the top of the popup. Enter in the information
and click Save to save your entry and return to the order. At least one entry must be the preferred
contact method.
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Pop-Up Screens — Phone Detail

/2 Phone Detail -- Webpage Dialog
€| https/idemo Litidx.com/fgvidt_redirect app?MODAL=idt_enter_ph + ¥ Certificate

* Phone type:

| Select Phone Type |

* Phane number:

(| ) | - Ext:

Preferred Phone? |:|

https: ffdemo Liitdx. com fgwidt_redirect app?MODAL=IdE_et G Intermet a =

This screen is used to enter Phone Numbers for the Insured.

The Phone Type drop-down allows you to create multiple phone numbers for the same person.

Pop-Up Screens — Email Detail

/2 Email Detail -- Webpage Dialog

€| hitps: /idemao Litidx.com/gvidt_redirect app™MODAL =idt_enter_err » ¥ Certificate

* Email type:

Select Email Type %

* Email addres=s:

Preferred Email? |:|

https: ffdemo Liitdx. com fgw Adt_redirect. appeMODAL =idt_ear 0 Internet a 2%

This screen is used to enter email addresses for the Insured.

The Email Type drop-down allows you to create multiple email addresses for the same person.
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Additional Options

There are additional options found on the left hand side of the screen.

e Carrier/Applicant — Clicking the Carrier/Applicant link will take you to the
Carrier/Application section of the Screen.

e Case — Clicking the Case link will take you to the Case section of the Screen.

e Requirements — Clicking the Requirements link will take you to the Requirements
section of the Screen.

e Put on Hold — Sometimes when you are creating an order, you may need exit the
system and return later to the order.

If you click Put on Hold the “Order Status” screen will be displayed. The “Order Details”
screen will still be visible. You will have the ability to click on the “Back to View Order” tab
to go back to the “New Order” screen that was displayed prior to clicking Put on Hold.

To put an order on hold, click Put on Hold on the left side of screen while in the Order
Details screen. On returning to the order, click the Back to Order button at the top of the
screen.

You can only work on one new order at a time. If you put an order on hold, you must

NOTE either finish the order or cancel it next time you enter the system.

e Cancel Editing — Clicking the Cancel Editing link will display a confirmation screen
where you can confirm that you wish to stop editing the order. This is cancelling the order
without saving.

Microsoft Internet Explorer E]

?/‘ Do ol wank bo cancel editing this Ordery
=

[ Ok, ] [ Cancel

Submit Order

Clicking Submit Order will submit orders for processing. It is in each of the three sections of the
screen to eliminate the need to scroll to the bottom of the screen.

Once all the required information has been entered:
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Click Submit Order.

A confirmation screen will be displayed. Use this screen as a confirmation that the
information that has been entered on the screen is correct.

If the information is correct, click OK. The Service Order will be created and routed to the
Service Provider.

If the information is incorrect and needs editing, click Cancel to go back to the Order
Detail screen and make any modifications.

|2 [Oracle QuickView] - Order Details -- [NEW] - Windows Internet Explorer

| htips:/fdemo Litidx.com/gw/Q¥_ORDER _DETALS. do?ACTIONCODE=NEWCORDERBNOCACHE = YBNEWWIN=Y ~ | @ Certificate
) REQUIREMENTS: hec
LatresiSinbeens EXAM Services: [ Apps -
-Case Y .
) Let examination company select Exam Services
fioquirementy @ Letme select Exam Services
i Collect Addiional Blood Sample
Collect Additional Urine Specimen (HOS)
[Cancel Editing]
Collect Blood Sample
[ coliect Blood Sample- Mark for CBC
§ -
Windows Internet Explorer R‘
Ol @ Yol are about to submit a new Service Order.
E Applicant: Santosha Test
- Palicy Mo: GOA122344
£ Carrier: Empire General
Plan: EG Alternative (Universal Life - Life)
O Face Amount: 500000
0 Reqguirements:
H -- Colect Additional Blood Sample - APPS
-- Collect Additional Urine Specimen (HOS) - APPS
O -- Collect Blood Sample - APFS
5 - Perform 1 View X-Ray (Frantal) - APPS
-- Perform EKG f ECG -Stress or Treadmil - APPS
E -- Perform Examination By Paramed - APPS
S -- R-Ray-Chest, PA and Lateral - APPS
N -- Obtain Attending Phiysician Statement - Portamedic
REPORTING Services: [ pl
b Do you want to proceed ?
E
L
I
[]  Prepare Inspection Report
[0 Prepare Motor Vehicle Report
First Test on Jan 12th Morning - Reporting Services
Hotes {up to 1000 chars)
| e s secton | [
v
Done ’—g Q Internet ns

If all the required information has not been entered, an Incomplete Order Screen will be displayed
identifying the Required Values that have not been entered and are required.

Microsoft Internet Explorer, r5_<|

The Order infa is nok complete,
! Please complete the Following daka First before submitting the Order:

- Gender
- Base Plan

e Click OK to remove Error screen and return to the Order Details screen to enter the
missing information.
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Service Orders Tab

The Service Orders tab has four options:

e New Order —to place a new order.

o Updates — displays the orders for your agent number that have been updated since the
last time you logged in.

e Summary — a listing of all orders for your agent number.
e Orders — the order details of the order you are currently in.

Updates

The Updates screen lets you immediately see where your orders are in the process. The Updates
screen shows only those orders recently updated. Recently updated means those service orders
where a Service Order Status Message has been received since the last time you logged in.

¢ [Oracle QuickView] - Orders - Windows Internet Explorer b E J
@ )= &1 nttps /fdemo Libdx, com/qv/Q¥_ORDERS doPACTIONCODE=REFRESH ~ | @ certiicate IZE || 2]~
J\, 4}\? |@[Orac\e GuickView] - Qrders ‘ | i‘-:h b R | o - jPage v Q¢ Tools »
ORACLE’
INSURANCE QuickView | Service Orders

Logout Home Help
Tools  Policies  Commission

Order Summary Order Details
New Order

e search: | Order (by Applicant Name) v || | E3
Search Options | || summary lems per Page: Page 10f1
spplicant first or last Name: Orders r  Provider Case Status s pos Entered Date Provider Order ID
| o[ New Search b787-  APPs 5 Submittes 585-89-8345 010741878 01/1212008 10:13:58
Applicant SEN o R i1 o

0111212008 Test Santosha  DO7-94-45606787- APFS 5 Submitied 586-89-8345 01071978 01/12/2008 10:13:43
| 46606786 Al
Applicant DOB (DDA 0140812009 Test, Mark € 4 Submitied to Provider §73-00-9010 01011980 01/08/2008 11:48:29
L 0110912008 RajeTest E Submitied a78-24-8585 011121980 01/09/2008 10:10:49
Policy Humber: RamboTest

AN
[

Service Provider [Resef]
APPS

Order Status
Insco
Order Number.

Provider Order D:

Status Updated

Entersd Date

| reser [ searc

Writing Agent User: test test Copyright ® 2008, Oracle All rights reserved

@ @ ntermet #100% -
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You can customize what orders are displayed on the Updates screen by editing your Service
Order Settings. To change your criterion for order update notification, go to Tools>»Preferences
and click Service Order Settings. Then scroll down and use the dropdown menu for Display

Order with Updates to select the criterion your want.

Introduction to Summary

When you click the Summary link, you will be taken to the Order Summary screen.

& [Oracle QuickView] - Orders - Windows Internet Explorer

@ A |ghttps://demo1‘uudx.com/qv/QV_ORDERS‘do

~ | Certificate |v7 X ‘

|2

,\\ 4}-‘3 (& [Cracle QuickView] - Orders

ORACLE’
INSURANCE

Tools Policies Commission

QuickView

Service Orders

Search Options -

Applicant first or last Name:

{h B

»
= - :}Page' G Tools ¥

Logout Home Help

QOrder Summary Order Details

Applicant SEN

Applicant DOB (MW/DD/YY)

Policy Number.

New Order
Updates | Order by Appiicant name) | s || | E3
Summary lems per Page: Page 1 0f 1
e r  Provider case Status s@ePUrder ID
0| New Search - APPS - Submitted
011122008 Test Santosha ApPS 5 Submitted 585-89-8345 01/12/2008 10:13:43
Al
01/08i2008 Test MarkE 5216 APFS 4 Submitted to Provider 573-00-8010 010111860 01/08/2008 11:45:38
Al
01/09/2009 RajaTest . APPS El Submitted 878-24-6565 0111211880 01/09/2008 10:10:49
RamboTest

Service Provider [Resef]
APPS

Order Status
Insco

Order Number:

Provider Order D:

Status Updated
Entered Date.

SEARCH

AN

Writing Agent User: test test

Dane

Copyright © 2008, Oracle. All rights reserved

j} g Internet

H100% -

The Summary screen has three tabs located on the far right side of the screen:

e Order Summary — The Order Summary screen is used to display all service orders
created by each service provider

e Order Status — The Order Status screen shows the status of all orders in the system.

e Order Details — The Orders Details screen displays the read only details for the row
chosen from the Update Screen.
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Order Summary

The Order Summary screen is used to display all service orders created by each service provider.
Service Providers will be listed along with the total number of service orders created for each one.

You can drill down into the service provider details by clicking the service provider name. This will
expand the list to include order status. By drilling down even further, you can view the insurance
companies that have service orders with the provider and status.

& [Oracle QuickView] - Order Summary - Windows Internet Explorer: E]@
K3 ) [l hips:demod . comjav/Qy_CROER_SMMARY.do v | @ cerniicate |/l | |2~
,‘, 4}-‘3 (& [Cracle QuickView] - Qrder Summary f'-fh - = - :}Page ¥ i0f Tools ¥
ORACLE’
INSURANCE QuickView Service Orders

Logout Home Help
Tools Policies Commission

Order Status | Order Details

Search: | Qraer (by Appiizant lame) v || 13
e Scarcn Dpions] [Pren
Applicant first or last Name: Service Provider > Order Status > Insurance Company > Agency Total Orders
| = APPS 4
Applicant SSN = Portamedic 3
| = MediConnect 1

Applicant DOB (MW/DD/YY)

Policy Number.

Service Provider

Order Status
Insco

Order Number.
Provider Order ID:
Status Updated
Entered Date

| ReseT [ searcH

[xzHide Search Optiong] [Pref]
Service Provider > Order Status > Insurance Company > Agency
& APPS

i~ = Submitted
= I+ Submitted to Provider
“ { Empire General Life
* m UNASSIGNED
= Portamedic
= MediConnect

Writing Agent User: test test

Dane

Clicking the number of Total Orders will place you on the Order Status screen where the orders
that fall into the category that was chosen will be displayed.
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Pref

Click the Pref link on the Order Summary screen will bring up the Preferences screen. On this
screen, you can select the grouping displayed on the Order Summary screen.

/2 Preferences -- Webpage Dialog g|
& | https: fidemo Litid: | 1§ Certificate

Order Summary Groups: [Set to Default
Service Provider w

Order Status b

Ingurance Company | w

[save [ close |

https://den € Internet a o
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Order Status

The Order Status screen shows a summary view of the orders for that agent number.

& [Oracle QuickView] - Orders - Windows Internet Explorer

@ A |g https :/fdemo Litidx.com/gv/QV_ORDERS.do ~ | Y Certificate | vy K ‘ ‘ P~
A 4}: (& [Cradle QuickView] - Orders "-:h h -y - %Page v & Tools
ORACLE
INSURANCE QuickView | Service Orders

Logout Home Help

Tools Policies Commission

Order Summary Order Details

Search: | Order (by Applicant Name) (v || |3
xeHide Search Options] [Pref] TEMS FOUND: 4 Rems per Page:

Page 10 1
Applicant first or last Hame: Status Updated «  Applicantfame  OrderNumber  Provider Case Status ssn D08 EnteredDate  Provider Order D
| 01/12/2008 Test, Santosha 007-94-45608787- APPS s Submited 588 014 878 01/12/2008 10:13:58
45606834 AN

Applicant SN . P = o

01/12i2009 Test, Santosha 007-94-45608787- APPS - Submitted 588-89-8345 01/12/2009 10:13:43
| 45606786 AN
Applicant DOB (MIDDAY) 0140912009 Test MarkE LA < Submitied to Provider 72-00-5010 011011960 009 1:43:28
| 0140912008 RaaTest 2 Subrmitied 878-24-6565 011121380 009 10:10:48
Policy Number: RamboTest

Service Provider [Resef]
APPS

Order Status
Inzco

Order Number.
Pravider Order D:
Status Updated
Entered Date

| rReser [[§ searcH

Writing Agent User: test test Copyright @ 2008, Oracle All rights reserved

[ @ @ nternet H100% -

Kinds of Order Status

A Service Order will have one of the following statuses:

Status Meaning

New Order entered but not yet submitted to the Service Provider.

Submitted Order orlglr)ated from the Service Provider. The request has already
been submitted.

Submitted to

. Order entered and submitted to the Service Provider.
Provider

In Process with

Provi Service Provider responded with a status on the Order.
rovider

All Services on the order have been either (a) completed or (b)

Completed completed and canceled.

Canceled All services on the order have been cancelled.
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To review the status of your orders, scan the orders column within the Order Status Screen. You
can see more case details by clicking on the case number.

NOTE The Update screen will also help you review orders that have recently changed

status.

NOTE If the status is completed, you can tell where it came from by looking at the order

history.

Each Row on the Order Status — Update screen will have the following columns:

Field Name

Description

Applicant Name

Name of Applicant.

Order Number

System generated number associated with the Service Order.

Provider Service Provider name associated with the Service Order.
Case System generated Case Number assigned to the Service Order.
Status Status associated with the Service Order.

Social security number of Applicant associated with the Service
SSN

Order.
DOB Date of birth of Applicant associated with the Service Order.

Entered Date

The date the Service Order was entered.

Provider Order ID

System generated ID assigned to the Service Order based on the
Service Provider.

Case

Clicking the case number will place you on the Order Details screen. The Orders Details screen
will display read only details for the row chosen from the Update Screen. The data display will be
data that was entered on the New Orders screen when the order was created.
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Order Details

The Orders Details screen has the details of the row selected on the Update Screen. The data
displayed will be the data that was entered when the order was created. This screen is read only.

¢ [Oracle QuickView] - Order Details - - Windows Internet Explorer

—— -
&)~ [l htsidemo Litdx.com/av/_CRDER_DETALLS, doPL ASTORDER=Y v @ Certicate B3
— . »
i\\? Eﬁ? I@[Orac\e Quick View] - Crder Detals — ] I Fﬁ e D amo - E);Pagev Q¢ Tools
ORACLE
INSURANCE QuickView | Service Orders
Logout Home Help
Tools  Policies  Commission Order Summary | Order Status
search: | Order (by Applicant Name) v || |3
SERVICE ORDER:

Entered Date’ gq,4212009

007-94-45506787-45606786 Carmier: Empire General Life

APPLICANT: Santosha Test Provider: pps

CASE: 5 Agency.

AGEN test, test

Order Requirements Agent Ho: pypagq
Agent Phone: 415 979.0604

Agency Phone

* Applicant Info
Case Info Applicant: Test, Santosha
Face Amount 5ng 000,00
Service Order Status: gpminted

Qther Requirements: First Test on Jan 12th Morning - Reporting Services

Preferences
i ] ipti Date Status Status Date Reason Location
ITQV-apagent- Perform EKG / ECG -Stress |01/13/2008 Outstanding 0171272008
2008012101235 1 or Treadmil

Ty

X-Ray-Chest, PA and 01/13/2009 Quistanding 0112/2009
20090112101235-Req1_2  |Lateral

ITQV-aipagent- Perform 1 View X-Ray 01/13/2008 Outstanging 01/12/2002
20090112101235-Req1_3  |(Frontal)

ITQV-aipagent- Collect Additional Blood 01/13/2008 Outstanding 01/12/2008
20090112101235-Reql1_4  |Sample

ITQV-aipagent- Collect Blood Sample 01/13/2008 Qutstanding 0171272008
20090112101235-Reg1_S

ITQV-aipagent- Collect Additional Uring 01/13/2008 Outstanding 01/12/2008
20090112101225-Req1_6  |Specimen (HOS)

Writing Agent User: test test Copyright ® 2008, Oracle All rights reserved.
Done ’—; 0 Internat % 100% -

Order History

To view the history of an order, navigate to the Order Requirements section of an order. Look for
a gold arrow to the left of the Requirement ID. If you see one, there is a status history for this
order. Click on the arrow and the status history will be shown.
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Orders

The Orders screen will display the details of the order that you are currently in. To view order

details, select an order on the Summary screen and then select the Orders option from the drop
down menu.

¢ [Oracle QuickView] - Order Summary - Windows Internet Explorer

——
@\ = |21 https:/idemo L. com/av/Q¥_ORDER_SUMMAR Y.do#id1,2.1

v | IE¥ Certificate | 5 K ‘
T = - - . »
W R I@[Orac\e Quick View] - Crder Summary ] I Fﬁ e D om0 - gy Page v () Tools ¥
ORACLE
INSURANCE QuickView | Service Orders
Logout Home Help
Tools Policies  Commission Order Status | Order Details
hNew Order

Updates Search: | Order (by Applicant Name) v || | E3
Agpplicant first or last Name: 8 Orders Jpany > Agency Total Orders
| New Search 4
Applicant 82N beb Submited El
| 4 Submitted to Provider 1
& Empire General Life 1
Applicant DOB (MW/DD/YY) B m UNASSIGNED 1
| = Portamedic 3
i 1
Policy Number = MediConnect 1

Service Provider

Order Status
Insco
Order Number:

Provider Order ID:

Status Updated

Entered Date.

seanc

Writing Agent User: test test Copyright ® 2008, Oracle All rights reserved.

@ @ ntermet 100% -

Done
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4

Searching

There are two search tools available for finding orders quickly:

e The Quick Search, located at the top right hand side of the screen.
o The Detailed Search, located on the left side of the screen.

Quick Search

A quick search can be done to find an order quickly. Any screen with a search menu on the upper
right hand side of the page will allow for a quick search. Quick searches are done on all orders for
that agent number by a specific criterion.

& [Oracle QuickView] - Order Summary - Windows Internet Explorer:

&3 )~ [el htpsyjidemo Litcx.com/ov/Qy_SROER_SUMMARY.do#id1.2.1 v & certiicate |[42/[ %] | |[o]-

»

A 4}: |@[Orac\e QuickView'] - Crder Summary ‘ | [':h © \J -y - QPage v & Tools

ORACLE i i
INSURANCE QuickView | Service Orders

Tools Policies Commission

Order Status | Order Details

New Order
_[Updates Search: | Order (by Applicant Name) (v || =
[ Summary
Applicant first or last Name: 4 Orders Jpany > Agency T
| New Search
Applicant 55N ¢ Submitied

Submitted to Provider
- & Empire Ceneral Life

I ks s e 1

Applicant DOB (MIWDDFYY) b UNASSIGNED
| = Portamedic

|Pchcy Humber: X .

Service Provider

Order Status

Insca

Order Humber:

Provider Order D:

Status Updated

Entersd Date

| reser [ searc

Writing Agent User: test test Copyright @ 2008, Oracle All rights reserved

[ @ @ nternet H100% -

Done

To do a Quick Search:

e Select the criteria you want to search by from the drop down menu.
o Enter in the parameters of the criteria in the text box.
e Click Go. The results will be displayed below.
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For example, if you want to search for all orders by applicant name, you would select Order by
Applicant Name from the drop down and enter in the name you want in the text box.

The quick search list is smaller and more concise than the detailed search.

Detailed Search

You can do a more detailed search by using the search tool on the left side of the screen. You
can enter in as many search criteria as you want. Generally, the more search criteria you enter
will reduce the number of results returned.

When using this tool to search through a lot of records, it is recommended that you first click on
Order Status. The Order Status field allows you to select the status of all the orders you want to
search through. This may reduce the number of orders returned and allow you to find the order
you need quickly.

ORACLE
INSURANCE QuickView Service Orders

Tools Pualicies Comimission

SEICDLLIIIE | lianide Search Options] [Pref]

Applicant firzt or lazt Name: Service Provider > Order Status > Insurance Company > Agency
| & APPS
HE c itte
Applicant SEN- = Submitted
| & Submitted to Provider
* & Empire General Life
Applicant DOB (MI/DDMN ™) = m UNASSIGMED
| = Portamedic
= MediConnect

Palicy Mumber:

Service Provider

Order Status
Ingco

Order Number:

Prowider Order IDv:

Statuz Updated

Entered Dats

| reser ] sewrce |
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Searches can be performed on any of the following fields:

Applicant First Name
Applicant Last Name
Applicant SSN
Applicant DOB
Policy Number
Service Provider
Order Status

Insco

Order Number
Provider Order ID
Status

Entered Date

There are five fields that will allow you to enter or select additional options to search on: Service
Provider, Order Status, Insco, Status Updated, and Entered Date. To view the options available,
click on the underlined field.

Service Provider — This field will display all of the service providers for your agent
number. First, click the Service Provider field. A list box of providers will be displayed.
You can select one or more providers to search on. Next, select the first provider you
want to search on. To select more than one provider, hold down the CRTL key when you
make your additional selections. When you leave this field, the options you have selected
will be listed.

Order Status — To limit your search to all orders that have results, you can select a
status option under the Order Status field. First, click the Order Status field. A list box of
statuses will be displayed. You can select one or more statuses to search on. Next,
select the first status you want to search on. To select more than one status, hold down
the CRTL key when you click the statuses you want. When you leave this field, the
options you have selected will be listed.

Insco — This field will display all of the insurance companies for your agent number. First,
click the Insco field. A list box of insurance companies will be displayed. You can select
one or more insurance companies to search on. Next, select the first insurance company
you want to search on. To select more than one insurance company, hold down the
CRTL key when you make your additional selections. When you leave this field, the
options you have selected will be listed.

Status Updated — This field allows you to select the date range of when your order was
updated. First, click the Status Updated field. Then, enter in the date range. You can
manually type in a date or choose one from the calendar.

Entered Date — This field allows you to select the date range of when your order was
entered. First, click the Entered Date field. Then, enter in the date range. You can
manually type in a date or choose one from the calendar.

Before starting a new search, it is good practice to click the RESET button. This clears out the
fields so you are only searching on the parameters you want.

Hiding the Search Bar

Search options can be left on screen or hidden. Hiding search options will make more work space
on the screen. If you want to hide the search options, click the Hide Search Options link
displayed at the top of the screen. Clicking the Hide Search Options link a second time will
restore the search options.
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Support

If you receive an error or need a question answered, please contact Oracle Insurance QuickView
Support at 1-888-486-4683 Ext.4 or send an e-mail to QuickView Support.

Address any additional inquiries to:

Oracle Corporation
World Headquarters
500 Oracle Parkway
BeSdVXOOd Shores, CA 94065

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com
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